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Chapter 160 

Non-Inferiority Tests for 
the Difference Between 
Two Correlated 
Proportions 
Introduction 
This module computes power and sample size for non-inferiority tests of the difference in which two dichotomous 
responses are measured on each subject. When one is interested in showing that the true proportions are different, 
the data are often analyzed with McNemar’s test. However, we are interested in showing non-inferiority rather 
than difference. For example, suppose a diagnostic procedure is accurate, but is expensive to apply or has serious 
side effects. A replacement procedure is sought which is no less accurate, but is less expensive or has fewer side 
effects. In this case, we are not interested in showing that the two diagnostic procedures are different, but rather 
that the second is no worse than the first. Non-inferiority tests were designed for this situation.  

These tests are often divided into two categories: equivalence (two-sided) tests and non-inferiority (one-sided) 
tests. Here, the term equivalence tests means that we want to show that two diagnostic procedures are 
equivalent—that is, their accuracy is about the same. This requires a two-sided hypothesis test. On the other hand, 
non-inferiority tests are used when we want to show that a new (experimental) procedure is no worse than the 
existing (reference or gold-standard) one. This requires a one-sided hypothesis test. The procedures discussed in 
this chapter deal with the non-inferiority (one-sided) case. 

Technical Details 
The results of a study in which two dichotomous responses are measured on each subject can be displayed in a 2-
by-2 table in which one response is shown across the columns and the other is shown down the rows. In the 
discussion to follow, the columns of the table represent the standard (reference or control) response and the rows 
represent the treatment (experimental) response. The outcome probabilities can be classified into the following 
table. 
 

 
 

Experimental Standard Diagnosis
Diagnosis Yes No Total

Yes
No

Total

p p P
p p P
P P

T

T
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01 00 1
1 1

−
−
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In this table, . That is, the first subscript represents the response of the new, experimental 

procedure while the second subscript represents the response of the standard procedure. Thus,  represents the 
proportion having a negative treatment response and a positive standard response.  

Sensitivity, Specificity, and Prevalence 
To aid in interpretation, analysts have developed a few proportions that summarize the table. Three of the most 
popular ratios are sensitivity, specificity, and prevalence.  

Sensitivity 
Sensitivity is the proportion of subjects with a positive standard response who also have a positive experimental 
response. In terms of proportions from a 2-by-2 table,  

Sensitivity =  
𝑝𝑝11

(𝑝𝑝01 + 𝑝𝑝11) =
𝑝𝑝11
𝑃𝑃𝑆𝑆

 

Specificity 
Specificity is the proportion of subjects with a negative standard response who also have a negative experimental 
response. In terms of proportions from a 2-by-2 table,  

Specificity =  
𝑝𝑝00

(𝑝𝑝10 + 𝑝𝑝00) 

Prevalence 
Prevalence is the overall proportion of individuals with the disease (or feature of interest). In terms of proportions 
from a 2-by-2 table,  

Prevalence =  𝑃𝑃𝑆𝑆 

Table Probabilities 
The outcome counts from a sample of n subjects can be classified into the following table. 
 

 
 

Note that 𝑛𝑛11 + 𝑛𝑛00 is the number of matches (concordant pairs) and 𝑛𝑛01 + 𝑛𝑛10is the number of discordant pairs. 

The hypothesis of interest concerns the two marginal probabilities 𝑃𝑃𝑇𝑇 and 𝑃𝑃𝑆𝑆. 𝑃𝑃𝑆𝑆 represents the accuracy or 
success of the standard test and 𝑃𝑃𝑇𝑇 represents the accuracy or success of the new, experimental test. Non-
inferiority is defined in terms of either the difference of these two proportions, 𝐷𝐷 = 𝑃𝑃𝑇𝑇 − 𝑃𝑃𝑆𝑆, or the relative risk 
ratio, 𝑅𝑅 = 𝑃𝑃𝑇𝑇/𝑃𝑃𝑆𝑆. The choice between 𝐷𝐷 and 𝑅𝑅 will usually lead to different sample sizes to achieve the same 
power. 

p pij Treatment Standard= ,

p01
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Non-Inferiority Hypotheses using Differences 
This section is based on Liu, Hsueh, Hsieh and Chen (2002). Refer to that paper for complete details.  

If we define 𝑀𝑀𝑁𝑁𝑁𝑁 as the positive non-inferiority margin, then the null and alternative hypotheses of non-inferiority 
in terms of the difference are 

𝐻𝐻0:𝑃𝑃𝑇𝑇 − 𝑃𝑃𝑆𝑆 ≤ −𝑀𝑀𝑁𝑁𝑁𝑁     versus     𝐻𝐻1:𝑃𝑃𝑇𝑇 − 𝑃𝑃𝑆𝑆 > −𝑀𝑀𝑁𝑁𝑁𝑁, 

or equivalently, with 𝐷𝐷0 = −𝑀𝑀𝑁𝑁𝑁𝑁, 

𝐻𝐻0:𝑃𝑃𝑇𝑇 − 𝑃𝑃𝑆𝑆 ≤ 𝐷𝐷0     versus     𝐻𝐻1:𝑃𝑃𝑇𝑇 − 𝑃𝑃𝑆𝑆 > 𝐷𝐷0. 

To demonstrate non-inferiority, one desires to reject the null hypothesis and thus conclude that the experimental 
treatment is not worse than the standard by as much or more than 𝑀𝑀𝑁𝑁𝑁𝑁. In the context of the preceding statement 
and as stated earlier, 𝑀𝑀𝑁𝑁𝑁𝑁 is defined to be positive. The choice of an appropriate 𝑀𝑀𝑁𝑁𝑁𝑁 may be difficult. It should be 
clinically meaningful so that clinicians are willing to conclude that the experimental treatment is acceptable if the 
difference is no less than 𝑀𝑀𝑁𝑁𝑁𝑁. From a statistical perspective, 𝑀𝑀𝑁𝑁𝑁𝑁 should be less than the effect, if known, of the 
standard treatment compared to placebo. 

Liu et al. (2002) discuss the RMLE-based (score) method for constructing these confidence intervals. This method 
is based on (developed by, described by) Nam (1997). 

Asymptotic Tests 
An asymptotic test is given by 

𝑍𝑍𝑁𝑁𝑁𝑁 =  
𝐷𝐷� + 𝑀𝑀𝑁𝑁𝑁𝑁

𝜎𝜎�
=
𝑐𝑐 + 𝑛𝑛𝑀𝑀𝑁𝑁𝑁𝑁

�𝑑𝑑 − 𝑛𝑛𝐷𝐷�2
≥ 𝑧𝑧1−𝛼𝛼 

where 

𝐷𝐷� =
𝑛𝑛𝑇𝑇
𝑛𝑛
−
𝑛𝑛𝑆𝑆
𝑛𝑛

=
𝑛𝑛10
𝑛𝑛
−
𝑛𝑛01
𝑛𝑛

 

𝑑𝑑 = 𝑛𝑛10 + 𝑛𝑛01 

𝑐𝑐 = 𝑛𝑛10 − 𝑛𝑛01 

and 𝑧𝑧1−𝛼𝛼 is the standard normal deviate having 𝛼𝛼 in the right tail.  

An estimate of 𝜎𝜎� based on the RMLE-based (score) procedure of Nam (1997) uses the estimates 

𝜎𝜎�𝐿𝐿 = �𝑝𝑝�𝐿𝐿,10 + 𝑝𝑝�𝐿𝐿,01 − 𝑀𝑀𝑁𝑁𝑁𝑁
2

𝑛𝑛
 

where 

𝑝𝑝�𝐿𝐿,10 =
−𝑎𝑎�𝐿𝐿 + �𝑎𝑎�𝐿𝐿2 − 8𝑏𝑏�𝐿𝐿

4
 

𝑝𝑝�𝐿𝐿,01 = 𝑝𝑝�𝐿𝐿,10 − 𝑀𝑀𝑁𝑁𝑁𝑁 

𝑎𝑎�𝐿𝐿,01 = −𝐷𝐷�(1 −𝑀𝑀𝑁𝑁𝑁𝑁) − 2(𝑝̂𝑝01 +𝑀𝑀𝑁𝑁𝑁𝑁) 

𝑏𝑏�𝐿𝐿,01 = 𝑀𝑀𝑁𝑁𝑁𝑁(1 + 𝑀𝑀𝑁𝑁𝑁𝑁)𝑝̂𝑝01 
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Power Formula 
The power when the actual difference is 𝐷𝐷1 can be evaluated exactly using the multinomial distribution. However, 
when the sample size is above a user-set level, we use a normal approximation to this distribution which leads to 

Power = �1 −Φ(𝑐𝑐𝑁𝑁𝑁𝑁) if 𝐷𝐷1 > −𝑀𝑀𝑁𝑁𝑁𝑁
0 otherwise

� 

= �1 −Φ(𝑐𝑐𝑁𝑁𝑁𝑁) if 𝐷𝐷1 > 𝐷𝐷0
0 otherwise

� 

where 

𝑐𝑐𝑁𝑁𝑁𝑁 =
𝑧𝑧𝛼𝛼
𝑤𝑤𝐿𝐿

−
 𝐷𝐷1 +𝑀𝑀𝑁𝑁𝑁𝑁

𝜎𝜎
=
𝑧𝑧𝛼𝛼
𝑤𝑤𝐿𝐿

−
 𝐷𝐷1 − 𝐷𝐷0

𝜎𝜎
 

𝜎𝜎 = �𝑝𝑝01 + 𝑝𝑝10 − 𝐷𝐷12

𝑛𝑛
 

𝑤𝑤𝐿𝐿 = �
2𝑝𝑝01 + 𝐷𝐷1 − 𝐷𝐷12

2𝑝̅𝑝𝐿𝐿,01 − 𝑀𝑀𝑁𝑁𝑁𝑁 − 𝑀𝑀𝑁𝑁𝑁𝑁
2 = �

2𝑝𝑝01 + 𝐷𝐷1 − 𝐷𝐷12

2𝑝̅𝑝𝐿𝐿,01 + 𝐷𝐷0 − 𝐷𝐷02
 

𝑝̅𝑝𝐿𝐿,01 =
−𝑎𝑎𝐿𝐿 + �𝑎𝑎𝐿𝐿2 − 8𝑏𝑏𝐿𝐿

4
 

𝑎𝑎𝐿𝐿 = −𝐷𝐷1(1 −𝑀𝑀𝑁𝑁𝑁𝑁) − 2(𝑝𝑝01 + 𝑀𝑀𝑁𝑁𝑁𝑁) = −𝐷𝐷1(1 + 𝐷𝐷0) − 2(𝑝𝑝01 − 𝐷𝐷0) 

𝑏𝑏𝐿𝐿 = 𝑀𝑀𝑁𝑁𝑁𝑁(1 + 𝑀𝑀𝑁𝑁𝑁𝑁)𝑝𝑝01 = −𝐷𝐷0(1 − 𝐷𝐷0)𝑝𝑝01 

Nuisance Parameter 
The 2-by-2 table includes four parameters, 𝑝𝑝11, 𝑝𝑝10, 𝑝𝑝01, and 𝑝𝑝00, but the power calculations only require two 
parameters: 𝑃𝑃𝑆𝑆 and 𝐷𝐷1. A third parameter is defined implicitly since the sum of the four parameters is one. Thus, 
one parameter (known as a nuisance parameter) remains unaccounted for. This parameter must be addressed to 
fully specify the problem. This fourth parameter can be specified using any one of the following: 𝑝𝑝11, 𝑝𝑝10, 𝑝𝑝01, 
𝑝𝑝00, 𝑝𝑝10 + 𝑝𝑝01, 𝑝𝑝11 + 𝑝𝑝00, or the sensitivity of the experimental response, 𝑝𝑝11/𝑃𝑃𝑆𝑆. 

It may be difficult to specify a reasonable value for the nuisance parameter since its value may not be even 
approximately known until after the study is conducted. Because of this, we suggest that you calculate power or 
sample size for a range of values of the nuisance parameter. This will allow you to determine how sensitive the 
results are to its value. 

http://www.ncss.com/


PASS Sample Size Software NCSS.com   
Non-Inferiority Tests for the Difference Between Two Correlated Proportions 

160-5 
 © NCSS, LLC. All Rights Reserved. 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the Design tab. For 
more information about the options of other tabs, go to the Procedure Window chapter. 

Design Tab 
The Design tab contains the parameters associated with this test such as the proportions, sample sizes, alpha, and 
power. 

Solve For 

Solve For 
This option specifies the parameter to be solved for from the other parameters. The parameters that may be 
selected are Power or Sample Size.  

Power Calculation 

Power Calculation Method 
Select the method to be used to calculate power. 

The choices are 

• Multinomial Enumeration 
Power is computed using multinomial enumeration of all possible outcomes when N ≤ Max N for 
Multinomial Enumeration (otherwise, the normal approximation is used). Multinomial enumeration of all 
outcomes is possible because of the discrete nature of the data. 

• Normal Approximation 
Approximate power is computed using the normal approximation to the multinomial distribution. 

The exact calculation using the multinomial distribution becomes very time consuming for N > 500. When N > 
500, the difference between the multinomial and approximate calculations is small.  

For small values of N (less than 100), the Multinomial Enumeration power may be overly optimistic because the 
discrete nature of the trinomial distribution results in the actual alpha value being higher than its target. To be on 
the safe side, we recommend that you use the approximate calculation. 

Max N for Multinomial Enumeration 
Only shown when Power Calculation Method = “Multinomial Enumeration” 

Specify the maximum value of N (sample size) that uses the exact power calculation based on the multinomial 
distribution. N's greater than this value will use the asymptotic approximation. 
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Power and Alpha 

Power 
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, 
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null 
hypothesis is not rejected. Here, a type-II error occurs when you fail to conclude non-inferiority when in fact it is 
true. 

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 
0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.  

Alpha 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true 
null hypothesis is rejected. Here, a type-I error occurs when you falsely conclude non-inferiority. 

Sample Size 

N (Sample Size) 
Enter a value for the sample size. This value must be greater than two. You may enter a range of values such as 10 
to 100 by 10. 

Effect Size – Differences 

D0 (Non-Inferiority Difference) 
Specify the difference, Pt - Ps, for which the treatment group will be considered non-inferior to the standard 
group. You can enter a single value such as -0.05 or a series of values such as -0.03 -0.05 -0.10 or -0.05 to -0.01 
by 0.01 in the range -1 < D0 < 0 and D0 < D1. 

D1 (Actual Difference) 
Specify the actual difference, Pt - Ps, at which power will be calculated. This value is used to calculated Pt using 
the formula 

Pt = Ps + D1. 

Often this value is set equal to zero, but this is not required. Enter values in the range D1 > D0. 

Be careful that the value you enter here along with other values in this procedure do not result in an undefined 
2×2 table. The values entered in this procedure must result in a 2×2 table whose cell values and marginal totals 
each sum to 1. 

Effect Size – Standard Proportion 

Ps (Standard Proportion) 
The proportion of Yes’s (positive responses or successes) when subjects receive the standard procedure. 

You may enter a set of values separated by blanks. For example, you could enter 0.50 0.60 0.70. Enter values in 
the range 0 < Ps < 1. 

Be careful that the value you enter here along with other values in this procedure do not result in an undefined 
2×2 table. The values entered in this procedure must result in a 2×2 table whose cell values and marginal totals 
each sum to 1. 
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Effect Size – Nuisance Parameter 

Nuisance Parameter Type 
Enter the type of nuisance parameter here. Unfortunately, the 2-by-2 table cannot be completely specified by 
using only the parameters Ps and Da or Ps and Ra. One other parameter must be specified. This additional 
parameter is called a “nuisance” parameter. It will be assumed to be a known quantity. Several possible choices 
are available. This option lets you specify which parameter you want to use. In all cases, the value you specify is a 
proportion. 

• P11 (% Positive Matches) 
The proportion of subjects that are positive on both tests. 

• P00 (% Negative Matches) 
The proportion of subjects that are negative on both tests. 

• P01 (% -Trt +Std) 
The proportion of subjects that are negative on the treatment, but positive on the standard. 

• P10 (% +Trt -Std) 
The proportion of subjects that are positive on the treatment, but negative on the standard. 

• P11+P00 (% Matches) 
The proportion of matches (concordant pairs). 

• P01+P10 (% Disagree) 
The proportion of non-matches (discordant pairs). 

• P11/Ps (Sensitivity) 
The sensitivity. 

Nuisance Parameter Value 
Enter the value of the nuisance parameter that you specified in the “Nuisance Parameter Type” box. This value is 
a proportion, so it must be between 0 and 1.  

Be careful that the value you enter here along with other values in this procedure do not result in an undefined 
2×2 table. The values entered in this procedure must result in a 2×2 table whose cell values and marginal totals 
each sum to 1. 
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Example 1 – Finding Power 
A clinical trial will be conducted to show that a non-invasive MRI test is not inferior to the invasive CTAP 
reference test. Historical data suggest that the CTAP test is 80% accurate. After careful discussion, the researchers 
decide that if the MRI test is 75% accurate or better, it will be considered non-inferior. They decide to use a 
difference test statistic. Thus, the non-inferiority difference is 0.05. They want to study the power for various 
sample sizes between 20 and 1000 at the 5% significance level. 

They use P01 as the nuisance parameter and look at two values: 0.05 and 0.10. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Non-Inferiority Tests for the Difference Between Two Correlated Proportions procedure 
window by expanding Proportions, then Two Correlated Proportions, then clicking on Non-Inferiority, and 
then clicking on Non-Inferiority Tests for the Difference Between Two Correlated Proportions. You may 
then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing 
Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Power 
Power Calculation Method ...................... Normal Approximation 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... 20 100 200 300 450 600 800 1000 
D0 (Non-Inferiority Difference) ................ -0.05 
D1 (Actual Difference) ............................ 0.0 
Ps (Standard Proportion) ........................ 0.80 
Nuisance Parameter Type ...................... P01 (% -Trt +Std) 
Nuisance Parameter Value ..................... 0.05 0.10 

Annotated Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results ──────────────────────────────────────────────────────────── 
Hypotheses:   H0: Pt - Ps ≤ D0   vs.   H1: Pt - Ps > D0 
 
 Sample Non-Inf. Actual Treatment Standard Nuisance 
 Size Difference Difference Proportion Proportion Parameter 
Power N D0 D1 Pt Ps P01 Alpha 
0.14284 20 -0.050 0.000 0.800 0.800 0.050 0.050 
0.12028 20 -0.050 0.000 0.800 0.800 0.100 0.050 
0.42323 100 -0.050 0.000 0.800 0.800 0.050 0.050 
0.28926 100 -0.050 0.000 0.800 0.800 0.100 0.050 
0.67771 200 -0.050 0.000 0.800 0.800 0.050 0.050 
0.46318 200 -0.050 0.000 0.800 0.800 0.100 0.050 
0.83244 300 -0.050 0.000 0.800 0.800 0.050 0.050 
0.60369 300 -0.050 0.000 0.800 0.800 0.100 0.050 
0.94287 450 -0.050 0.000 0.800 0.800 0.050 0.050 
0.75745 450 -0.050 0.000 0.800 0.800 0.100 0.050 
0.98206 600 -0.050 0.000 0.800 0.800 0.050 0.050 
0.85657 600 -0.050 0.000 0.800 0.800 0.100 0.050 
0.99651 800 -0.050 0.000 0.800 0.800 0.050 0.050 
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0.93172 800 -0.050 0.000 0.800 0.800 0.100 0.050 
0.99937 1000 -0.050 0.000 0.800 0.800 0.050 0.050 
0.96870 1000 -0.050 0.000 0.800 0.800 0.100 0.050 
 
* Power was computed using the normal approximation method. 
 
Report Definitions 
Power is the probability of rejecting the null hypothesis when it is false. 
N is the number of subjects, the sample size. 
D0 is the difference at which the treatment will be considered non-inferior to the standard. 
D1 = Pt - Ps is the actual difference at which the power is calculated. 
Pt is the response proportion in the treatment (experimental) group. 
Ps is the response proportion in the standard (baseline, reference, or control) group. 
The Nuisance Parameter is a value that is needed, but is not a direct part of the hypotheses. 
Alpha is the probability of rejecting the null hypothesis when it is true. 
 
 
Summary Statements ───────────────────────────────────────────────────────── 
For a one-sided non-inferiority test of the difference between two correlated proportions, a 
sample size of 20 subjects achieves 14.284% power at a significance level of 0.050 when the 
non-inferiority difference is -0.050, the treatment proportion is 0.800, the standard 
proportion is 0.800, and the actual difference between the proportions is 0.000. These results 
assume that P01 is equal to 0.050. 

 
This report shows the power for the indicated scenarios. All of the columns are defined in the ‘Report Definitions’ 
section. 

Plots Section 
  

     
 

These plots show the power versus the sample size for the two values of P01. In this example, we see that the 
value of the nuisance parameter has a large effect on the calculated power. 
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Example 2 – Finding Sample Size 
Continuing with Example 1, the analysts want to determine the exact sample size necessary to achieve 90% power 
for both values of the nuisance parameter.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Non-Inferiority Tests for the Difference Between Two Correlated Proportions procedure 
window by expanding Proportions, then Two Correlated Proportions, then clicking on Non-Inferiority, and 
then clicking on Non-Inferiority Tests for the Difference Between Two Correlated Proportions. You may 
then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing 
Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Sample Size 
Power Calculation Method ...................... Normal Approximation 
Power ...................................................... 0.90 
Alpha ....................................................... 0.05 
D0 (Non-Inferiority Difference) ................ -0.05 
D1 (Actual Difference) ............................ 0.0 
Ps (Standard Proportion) ........................ 0.80 
Nuisance Parameter Type ...................... P01 (% -Trt +Std) 
Nuisance Parameter Value ..................... 0.05 0.10 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results ──────────────────────────────────────────────────────────── 
Hypotheses:   H0: Pt - Ps ≤ D0   vs.   H1: Pt - Ps > D0 
 
 Sample Non-Inf. Actual Treatment Standard Nuisance 
 Size Difference Difference Proportion Proportion Parameter 
Power N D0 D1 Pt Ps P01 Alpha 
0.90026 374 -0.050 0.000 0.800 0.800 0.050 0.050 
0.90014 699 -0.050 0.000 0.800 0.800 0.100 0.050 
 
* Power was computed using the normal approximation method. 

 
This report shows that the sample size required nearly doubles when P01 is changed from 0.05 to 0.10. 
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Example 3 – Validation using Liu et al. (2002) 
Liu et al. (2002) give an example in which P01 is 0.05, P10 is 0.05, D1 is 0.00, D0 is -0.05, the significance level 
is 0.025, and the power is 80%. From their Table III, the sample size is 350. 

In this example, the value of Ps is arbitrary. We set it at 0.50.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Non-Inferiority Tests for the Difference Between Two Correlated Proportions procedure 
window by expanding Proportions, then Two Correlated Proportions, then clicking on Non-Inferiority, and 
then clicking on Non-Inferiority Tests for the Difference Between Two Correlated Proportions. You may 
then make the appropriate entries as listed below, or open Example 3 by going to the File menu and choosing 
Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Sample Size 
Power Calculation Method ...................... Normal Approximation 
Power ...................................................... 0.80 
Alpha ....................................................... 0.025 
D0 (Non-Inferiority Difference) ................ -0.05 
D1 (Actual Difference) ............................ 0.0 
Ps (Standard Proportion) ........................ 0.50 
Nuisance Parameter Type ...................... P01 (% -Trt +Std) 
Nuisance Parameter Value ..................... 0.05 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results ──────────────────────────────────────────────────────────── 
Hypotheses:   H0: Pt - Ps ≤ D0   vs.   H1: Pt - Ps > D0 
 
 Sample Non-Inf. Actual Treatment Standard Nuisance 
 Size Difference Difference Proportion Proportion Parameter 
Power N D0 D1 Pt Ps P01 Alpha 
0.80046 350 -0.050 0.000 0.500 0.500 0.050 0.025 
 
* Power was computed using the normal approximation method. 

 

The calculated sample size of 350 matches the results of Liu et al. (2002). 
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